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Small Stuff makes a Difference over Time 
Small things make a huge difference over time. How we start 
our morning, how we greet staff, how we manage our time, 
how we listen and how we invest in our health all makes a 
difference over time.  

It’s all about the Small Stuff is about constantly seeking those 
small changes that improve your opportunities and those 
around you. And it’s about creating successful habits that 
maintain and grow our success. 

Here are two reasons why this is so important: 
1. We are all so busy that we need to return to a focus on the 

basics and how be effective at work and at home. And 
effectiveness, in this context, is about the long term impact 
we are having for our time investment (think ROI on ‘you’!). 

2. As leaders we need to ‘do the right stuff’, not just ‘do stuff 
right’; we need to keep our vision beyond today’s challenges to some future 
goals that we desire and we know are possible. We need to also be prepared to 
share and mentor junior staff and to present a positive, successful role model 
for them. 

Ok, here we go…. 
I have compiled these notes from my presentation with you and from previous 
presentations. The purpose of these notes is to give you more background 
information for each topic. You can also go to my web site to get more information 
and to read my current thinking on my blog. www.HughCulver.com 

 
I would also love to hear from you. Send me a note to let me know how my work is 
influencing you success. hugh@HughCulver.com 

 

 
“What man actually needs is not a tensionless state but rather the striving and 

struggling for a worthwhile goal, a freely chosen task.” Viktor E. Frankl, 
Holocaust survivor; author of Man’s Search for Meaning 

  



   Hugh Culver’s PRESENTATION NOTES 
Performance habits for daily excellence      

                    Copyright © 2010 Marathon Communications Inc.  All rights reserved. 2 
This document may not be reproduced or distributed in any manner without written permission. 

www.HughCulver.com  

Goal Driven, Success Ready  
When you are ‘goal driven’ you are working from a plan and you have ‘metrics’ of 
success that you can measure (sales, repeat customers, $’s, etc.) the minimum 
planning tools you need are your long-term plans, your “Action Plan” (plan for the 
week), your Day Plan. 

Success Ready means that you are open to what opportunities you attract. This 
could mean that you are taking breaks to reassess your day/week, turn work off 
when you go home, or attend seminars and other opportunities to expand your skill 
set. 

Goal Driven: Plan for the Week 
“Those that don’t have goals are ruled by those that do.” 

The week is the perfect length of time to blend your long term goals with daily 
action. Every Friday take 15 minutes and thoroughly review your week: what 
worked? What didn’t? What could be changed? As you do this look for patterns that 
are appearing: are you overestimating what you can accomplish? Are you doing 
work what someone else could do? Do you have time for professional development 
scheduled? How well did you take care of your health and fitness this week? 

Create an Action Plan with a short list of high level 
goals (this should not be a ‘shopping list’ of tasks). 
Remember to include routine objectives (like 
scheduling, coaching, etc.) as well as personal goals. 

Create your Day Plan for the day every evening. Avoid 
the temptation to put too much on your list. This 
should be a reasonable commitment and it should link 
to your Action Plan for the week. 

Finally, keep both plans visible all week. And after an 
interruption, return to your Action Plan (plan for the 
week), instead of your plan for the day. Remember you 
are always measured on what you got done, not on 
what you planned in your day. 
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Success Ready: Review, Refocus 

“Nothing is as fatiguing as the hanging on of an uncompleted task.”  
William James 

If we are only goal-driven we can miss out on opportunities that could be right in 
front of us. Opportunities could come from customers, staff, colleagues or through 
all of our social media or email connections. It’s like going to a conference but 
being convinced there is nothing new from the presenters. Any potential nuggets 
will be lost before they have a chance to be tried.  

It’s like when I am complimented after a speech if I didn’t use that opportunity to 
learn more then I’ve learnt nothing new. I need to thank the person and ask what 
did they find valuable, or what is one thing I could do to improve. 

When we were in the tourism industry it was easy to fall into the trap of thinking 
that our customers loved us. Our programs were great, the trips were full and 
everyone seemed happy. Great, but obviously we aren’t going to grow if we think 
everything is hunky dory. Only when we ask for feedback (and be prepared to 
openly accept it) were we able to learn.  

And it’s no different with your staff: you need to create opportunities for them to 
give you open and honest feedback. Operating under the assumption that 
everything is great could be a short lived illusion that comes crashing down one 
day.  

Just like when you are on a long hike, you need to stop and get your bearings. At 
work, at least twice a day, take time to review and refocus. Ask yourself what is on 
my list that doesn’t need to be there? And what is the most important work I should 
be doing right now? 

A great way to refocus is to combine your review with a short walk outside. The act 
of walking stimulates your physiology, releases endorphins and changes your focus – 
all of which can help to increase optimism and creative thinking. 

Hint: act like it is the day before vacation and watch how your 
attitude and results change! 
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Clear the Clutter 

When you can see unfinished work, or you are worrying about some issue at work 
you are filling up your available ‘RAM’. In the 1960’s Harvard researcher George 
Miller theorized that we have a mental capacity for about seven thoughts at any 
given time (think of this as your mental RAM). When you are thinking about the 
meeting you just left, emails you need to reply to, a phone call from a client, etc. 
You are using up your capacity to focus on your client or make good decisions. 

Clearing the Clutter can include the obvious areas like your desk, all those sticky 
notes as well as your mental focus. While most people believe that ‘clutter’ has 
little impact on their effectiveness, research 
has found that even Generation X-Game-Boy/X 
Box fanatics are terrible at multi tasking. In all 
research cases speed of completion, accuracy 
went down (at the same time, stress levels rose) 
when subjects attempted to multi task on even 
simple tasks. And, at the same time, stress 
levels rose. 

Here is a quick test: close your eyes and count 
to ‘50’ and notice what number you reach 
before a new thought entering your 
consciousness. Most people that take this test 
only get to about 15 before their mental 
distractions take over. How about you? 

Here are some tips for Clearing the Clutter: 

Clearing the Clutter can start with a quick 10 minute purge of your workplace. Just 
start with putting away all the files, reports, disc’s magazines, brochures that have 
a ‘home’. This should quickly remove about one half of the clutter. It can also 
involve creating a “Stop Doing” list of all the low-value tasks and repetitive jobs 
that you no longer value or want  

Learn how to use our Outlook Tasks on your computer. In particular get familiar 
with using ‘Categories’ to segment all your tasks (you have to go to View>Current 
View>By Categories). I have categories for: Boulders (big projects), Action Plan 
(this week), Blogs (writing project ideas), Family, Research, etc. 
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Don’t forget to ‘turn’ your work off on the way home. Less mental ‘clutter’ equals 
better quality of time at home. I find that before leaving work I need to record 
what I will work on when I return, otherwise I am thinking about it all the way 
home. 

New Systems. When you start clearing the Clutter you will realize that many things 
don’t have a home, like post-it notes, reports, magazines, etc. This is normal, but 
not an excuse!  

Every week look for three culprits 
that keep showing up and find a 
permanent home for them. For 
example, I have a system for 
storing all my passwords1, reading 
material, papers related to 
projects I’m working on, notes 
from meetings and random notes, 
quotes and thoughts2. 

When I am clutter free in my 
work environment I feel less 
burdened, more open to new ideas and more creative. Heck, I think I even sound 
better on the telephone. This is small stuff – but potentially huge in impact. Choose 
one type of clutter and create a new solution today. Notice how that feels and if 
there is any impact. Make another change later this week. Again notice the change. 
Now you are on a roll! Keep finding one or two types of items and remove them 
from sight. You brain will love it! 

  

                                         
1 Check out http://www.roboform.com/ this is a free tool that remembers all your usernames and 
passwords. It’s easy to use and keeps all the information on the web, so it’s safe and portable. 
2 I’ve been using http://www.evernote.com/ it’s also free and a simple way to collect and organize 
random thoughts. I even include photos I take of articles, flip charts, drawings of web pages, 
whatever. You can tag the entries to easily cross reference for finding later. 
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CLEAN YOUR WINDOW 
We all create Windows on the World – these are the judgments 
we make about challenges, people, work, clients, and our own 
abilities. These Windows can be good ones that serve our 
growth and success (like “I am good at creating and 
completing goals”) or quite destructive (like “I am a 
procrastinator”, or “they aren’t committed to the team”).  

Either way, they are only Windows and they can be changed. 
The facts about Windows are: 

 We create our Windows. 
 We forget we made them up(!) 
 We act as if they are true. 
 We look for evidence to prove they are true. 

“It’s not what we don’t know that prevents us 
from succeeding; it’s what we know that just 

ain’t so that is our greatest obstacle.” 
Author Josh Billings 

When we operate as if our Windows are true we are missing out on many other 
interpretations that may serve us better. Whether the Window is a good one and 
serves us, or it doesn’t serve us, it can quickly become a self-fulfilling prophecy. 

For example, if you think a person you work with doesn’t care about their work 
(the way you do) your relationship with them could be negatively impacted. In 
turn, they may notice this change and respond by distancing them self from you. 
Over time you will notice their reaction and use it to reinforce your belief that they 
don’t care about their work and you add that they also are not a good team player.  

What started from a single behaviour that you noticed now has become a self 
fulfilling prophecy that has changed the relationship. 

“What we think we become.” 
Gautama Buddha 563‐483BC 
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Here are three excellent ways to “Clean your Window”: 

1. Accurate Thinking 

The temptation we have when things are not going the way we want is to see the 
worst. It is human nature: we need to keep ourselves safe, so we predict the worst 
possible outcome, see the worst in the other person, and doubt our own 
capabilities. And then we start to believe our own stories (Windows). 

One fast way to move from this evaluation back to observations (unadulterated 
facts) is to exercise accurate thinking. Simply ask: ‘what (really) happened?’ One 
way to structure this questioning is in two columns: left column is “What is good 
about this/what went well?”. The right hand column is entitled “What is not good 
about this/what did not go well?”. Only record facts: observations, facts, and 
conversations: avoid evaluations, judgments and assumptions. 

Once you have your lists, evaluate them in terms of how you want to respond based 
on the facts. When I do this it completely changes my focus from “what happened 
to me?” to “what can I do next?”. 

2. Most Respectful Interpretation (M.R.I.) 

When you are disappointed or upset with someone your Window will 
start to ‘colour’ your  future interactions with that person. You may 
notice that you are more judgmental, reserved, less curious and 
even blaming. 

Instead ask yourself “What is the Most Respectful Interpretation I 
can make of what happened?”. This question will allow a new, better Window to 
emerge and can allow you to have a more productive conversation with the other 
person. You can also use it on yourself! The point here is not to necessarily let 
people “off the hook” but rather to move to curiosity before you have the 
conversation. In this way you open up more opportunities to happen. 

Try it out! The next time someone does something at work that upsets you. Stop 
and ask yourself “What is the MRI?”. Even if your answer is somewhat ridiculous, go 
with it. The point is not about coming up with a new, accurate interpretation. The 
objective is to move from blame to a more productive state of mind and then to 
react differently. 
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3. Ask better questions 

When we “create” our Windows on the world we move to thinking and acting from 
a place of evaluation. From this place we stop seeing opportunities that might shift 
us to a new Window, instead we typically see evidence that we are right! Just 
notice what happens when you go into a store and feel like you are getting bad 
service. Notice how your evaluations become more negative and how you start to 
notice more examples of “bad service”. 

By asking better questions you can start to challenge your evaluations and open 
your mind to new interpretations and new possibilities. For example, instead of 
asking “Why do I have all this work?” ask “Who is one person I can get to help 
me?”, or “What can I get done in the next half hour that will make a difference?”. 
Our mind is wired to try to answer questions; use questions to challenge your 
thinking and stimulate new solutions. 

Build your Asking Muscles! 
When we ask others for advice, help, commitments, sales, etc. we are 
acknowledging their value and we are getting better and exerting our asking 
muscles. As leaders when we ask followers for feedback or advice we show that we 
value them and care about what they think and value. As co-workers, when we ask 
we honour our co-worker and show that are open to learn. 

But what gets in the way of Asking is the belief that “I must be right” or Practice a 
reframe on these beliefs.  

Instead of “I must be right” try “I grow and become stronger by 
understanding others”  

Instead of “Asking is a sign of weakness” try “Only strong, confident leaders 
are willing to be curious.” 

For one week practice asking: 

 In stores ask for what you want. And if you are not happy, ask for a solution. 
 In meetings ask for what you need to make this the most valuable use of 

your time possible 
 With colleagues, ask for feedback on your performance 
 With your boss, ask for feedback to help you grow in your job 
 With your team, ask for feedback to increase your awareness of your 

contribution to the team 
 In sales, ask for the sale. You will never know until you enquire and the 

customer may never go the next step unless you do. So now you can both 
win! 
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BONUS MATERIAL 
Create a Stop Doing list 
What are you spending time on that you don’t need to? I know that I have a habit of 
‘collecting’ responsibilities and rarely reassessing whether I should still be doing 
them. The downside of this habit is that we accumulate more work and 
responsibilities than we need or want. 

Just for fun imagine that you have become your own coach. For one week look at all 
the tasks, errands, commitments and routines that you naturally commit yourself to 
and ask “Do I really need to do this?”. If not, get it off your mental or written “To Do” 
list and put it on your new “Stop Doing List” 

We all create a “glass ceiling” to our success and health based on the beliefs we 
have and also by how busy we keep ourselves. This glass ceiling is based on the 
stories that we tell ourselves; the good, the bad and the just plain old ones.  

For example, if you think you are busy, your glass ceiling is lower and you ‘repel’ 
new opportunities. Conversely, on the day before vacation you can become a super 
hero, being decisive, succinct in your conversations and fast at getting work done. 
It may even seem like you are getting twice the work done in the same amount of 
time!  

But here’s the crazy thing: it’s still you 
and you haven’t gone anywhere yet! You 
have just changed what you make 
important and raised your glass ceiling. 
On that one day you have changed your 
priorities and minor irritations and tasks 
no longer get in your way. 

What are on your lists that, given a 
choice, don’t need to be there? A stop 
doing list is an exciting opportunity to 
raise that ‘glass ceiling’ and create more 
capacity by freeing up your time and 
obligations. Here is my list for 2010 (steal 
what you like): 

  

1. Driving with cell phone 

2. Eating at my desk 

3. Working through breaks 

4. Needing to finish books, magazines 

5. Seeking perfection 

6. Fake delegation 

7. Procrastinating about my health 

8. Allowing work to stay ‘ON’ 

9. Lists for the weekend 

10. No news1 
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Walk the talk  
Whether you want to be, or not, you are a role model for staff; 
they look to you as an example of success. Yet, the pressures 
of work can lead to a disconnect between what is professed as 
ideal and actual results. In other words, sometimes we don’t 
walk out talk. 

Here are some areas to watch as you walk your talk: 

 Keeping promises, however small, like: calling someone 
back, on time for meetings, doing what you say you will. 

 Listening with all of your attention. The emails and 
paper can wait, when you are with someone give them 
all of your attention – it will pay off. 

 Your time management. Do you have a simple, easy to use system for 
appointments, goals and tasks for the week and day? 

 Your health. Are you taking time to maintain your good health? Take as little 
as 30 minutes a day for light exercise (brisk walking, cycling, stairmaster, 
treadmill, running, etc.). Do this at least five times a week and the results 
will be huge for you and for your team. 

“We have to be the change we want to see in the world.” 
Gandhi 
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Get off the email 
One of the best changes you can make to your productivity is to do less! I mean (of 
course) do less email. Think about this: if you were to cut back your time on email 
by just 10 minutes a day. That’s easy, right? Just 10 minutes a day is equivalent to 
about one full work week a year! That’s one week to redirect to more important 
work, to complete a project, to connect with a colleague to invest in professional 
development, whatever. Small stuff really does make a big difference. 

Here’s my top 10 list for ways to get out of your InBox and back to work: 

1. Goal: limit time spent. For one day pay attention to how long you are 
spending on email. Count up all the times you check your Blackberry, 
while commuting, at the office etc. Then take that total and reduce 
it by 20%. That’s your goal (OK if that freaks you out, start with 10%). 
I have gone from about four hours a day to now I will spend about 
one hour on email a day maximum. 

2. Use the right medium. Email is perfect for facts, dates, data, etc. If there is any 
emotion, confusion, controversy, or relationships involved, stand up and walk 
down the hall or pick up the phone. 

3. If you open it, deal with it. This is like the old habit of ‘Only touch a piece of 
paper once’. You have lots of options: reply, forward, etc. Here are two you 
may not use: Drag and Drop to Calendar or to Tasks. When you have an email 
that is a confirmation of an upcoming event go to Calendar. Emails for future 
tasks go to Tasks. Also if you right click as you move it Outlook will allow you to 
bring the attachment with the email and the option to remove the email from 
your InBox (instead of copying). Try it, this is a big time saver. 

4. Turn notification off. Remember my warning: ‘Those that don’t have goals are 
ruled by those that do’. Don’t let someone else’s panic attach rule your day. 

5. Use the Subject Line. Try this for one day. Treat email like a Tweet: put your 
whole message in the subject line. 

6. Restrict emails to one topic. Easy to sort, easier for the receiver, good 
discipline. 

7. Create standard replies. In Outlook ’03 use Signatures, in ’07 use Signatures or 
QuickParts. 

8. Limit the use of CC’ing. Enough said: do the math, overuse of CC’ing is an 
example of exponential growth gone bad. 
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9. Use ShortCut Keys. This is an easy win (along with improve your typing speed!). 
Here are ones to learn:  

All Microsoft programs use the same editing shortcut key combinations e.g. CTRL+B 
for bold and CTRL+Z,  CTRL+X,  CTRL+C,  CTRL+V 

CTRL+SHIFT+M - Create a new e-mail Message 

CTRL+SHIFT+K -Create a new Task 

CTRL+SHIFT+A -Create a new Appointment 

CTRL+SHIFT+C -Create a new Contact 

10. Use Organize to pre-sort. Step one is to create folders (right 
click on InBox) for committee work or for people that you 
regularly communicate with. Step two is to Right click on 
their email, go to Create Rule and follow the instructions. 

The following steps will create a rule that will instruct 
Outlook to store your reply in the same folder that the email 
was redirected to: Go to TOOLS > OPTIONS > Preferences > 
Email Options > Advanced E-mail Options. and click “In 
folders other than the inbox, save replies with original 
message. 

I recommend that you try one of these each week for 10 weeks. If it works, keep it 
and make it a habit. If not, move on. Regardless of how many of these ideas you 
keep, I can promise you that there is at least 30 minutes a day waiting for you to 
recover.3 

  

                                         
3 In a study of our time management training participants the average time recovered after using 
these and related strategies was one hour (a day!). And this study was conducted one month after 
the training was completed. 
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Recharge time 
How do you recharge from work? It is easy to be drawn 
into the mission of your work and to give yourself to it, 
while other aspects of your health suffer. 

Being selfish to serve is not about being lazy or 
unaccountable. Rather it is about balance; allowing time 
to recharge through your non-work interests so that 
when you are at work you  are full charged and ready to 
serve others. 

My experience has been that I can easily ‘lose’ myself in 
my work. That’s great; being immersed in work that I love is a great opportunity. 
And what often falls off my calendar is personal care: getting enough sleep, 
managing my diet and quantity of food that I eat, exercise and mental ‘down time’. 

 Develop interests and habits that recharge you so that you have more to 
serve others with.  

 Time away from work 
 Personal hobby or other interest that distracts you from work 
 Reading just for the fun of it 
 Volunteering 
 Exercise and having a great diet 
 Not taking work home every night 

Note. If you have a hard time finding time for yourself with all of your 
responsibilities the trick (for me at least) is to create a bigger “pay off” from the 
non-work time than I get from the work. Just as the non-runner suddenly in 
inspired to start exercising regularly after they register for their first half marathon 
race, you can become inspired to change your habits as well. 
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Jump Start Your Day 
Just like and athlete, we should all prepare for our “event” 
called: “work”. The better you plan  your morning, the better 
you will succeed during the day. Here are some great ways to get 
a “jump start to your day”: 

 Prepare the night before. Record what you want to work 
on in the morning on paper and free your mind to think 
about non-work things.  

 Leave enough time in the AM. Give yourself a break and 
plan to arrive at work early. You will experience less stress 
and have a chance to prepare for your day. 

 Don’t read/listen to the news. New is mostly negative, you 
will be better off reading inspiring writing, poetry or even 
humour! Use your commute time to listen to educational 
podcasts, inspiring speakers or talking books. 

 Envision a successful day. This is not “positive thinking” – it works! Simply 
envision a successful day just before you start your day and let your 
“reptilian brain” take over. When you plant an image of having a successful 
day your mind is now open to attracting that to you. 

 Be generous with others. Serve to be served. Look for opportunities every 
day to support others. Maybe they need more product knowledge, or help 
getting out of client issue. Go out of your way to help and support them and 
your influence will grow! 

 Celebrate successes. We all respond well to celebrations as long as they are 
relevant and meaningful to us. Learn what people like and be quick to 
celebrate their successes. 

 Fake it till you make it! Even when you are tired or overwhelmed with work, 
you can still feel good about the day. It all starts with the belief that you 
can control your emotions and you can have an impact. Simply start to act 
like the day is going as planned and that it will end well and notice how this 
has a positive impact on your work! 

 

“Choose to create your own day. Don’t 
wait for someone else to.” 
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Hugh Culver MBA, CSP is an author of over 100 articles 
on personal success, master trainer, athlete, and a 
professional facilitator and speaker. He pioneered tourism 
flights to the South Pole, was a professional adventure 
guide for 18 years in British Columbia, Antarctica and the 
Yukon, whitewater kayaking competitor, mountain climber, 
endurance athlete and has even golfed at the North Pole!  

Hugh’s remarkable training programs and keynote 
presentations combine street-smart advice with an 
engaging and often hillarious delivery style that reaches 
over 25,000 people each year.  His clients include: Royal 
Bank of Canada, BC Lottery Corporation, Imperial Oil, Sun 
Rype Products, Food Services America, many provincial 
ministries, municipal governments and associations as well 
as four universities and colleges. 

Hugh D. Culver MBA is a Certified Professional Speaker (one of only 40 in Canada) a 
Certified Facilitation Professional (one of 80 in Canada). In addition to his 
professional work, Hugh is the founding director of Dare2Dream™, a youth 
leadership sea kayaking program on the West Coast of British Columbia.   

 

“We won’t be remembered for what we did,  
only for who we helped so they could do better.” 

Hugh Culver 

 

 

For more information about Hugh’s work visit 

www.HughCulver.com 

1.800.313.0799 
 

  

 


